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Getting Started 

Overview 
Microsoft Communicator for Mac 2011 works with Microsoft Office Communications Server 2007 
R2 to provide real-time collaboration between people in different locations. People can 
collaborate in real time by using several methods of communication, including instant messaging 
(IM), presence, Web conferencing, and audio/video (A/V) conferencing. Contacts that a user adds 
to his or her Communicator account can include coworkers in the same company and, if 
authorized, associates on federated networks.  

IM conversations are not limited to conversations with other Communicator for Mac users. With 
Microsoft Office Communications Server 2007 R2, Communicator for Mac users can have IM 
conversations with contacts who use Office Communicator for Windows and public instant-
messaging connectivity (PIC), such as AOL Instant Messenger (AIM), Yahoo! Messenger, and 
Windows Live Messenger. These accounts must have the required IM connectivity licenses. You can 
then authorize or deny federated access for an individual user or groups of users, and you can 
block federated partners from using IM with particular users.  

Intended audience 
The Microsoft Communicator for Mac 2011 Deployment Guide is for system implementers, IT 
managers, system administrators, or other people who plan for, implement, and maintain 
Communicator for Mac in their organizations. 

Communicator for Mac is available as part of Microsoft Office for Mac Standard 2011 as well as a 
standalone edition for volume licensing customers. For information about Office for Mac 2011 
deployment, see the Office for Mac 2011 Administrator's Guide .  

http://go.microsoft.com/fwlink/?LinkId=201945�
http://go.microsoft.com/fwlink/?LinkId=201945�
http://go.microsoft.com/fwlink/?LinkId=201945�
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Documentation roadmap 
This document guides you through planning and deploying Communicator for Mac in a corporate 
environment. The following table describes the chapter content. 

Chapter Description 

Getting Started  Details about the new features in Communicator for Mac and 
information about what you should consider when you 
upgrade to the new version 

Installing and Configuring 
Communicator for Mac 2011 on a 
Corporate Network  

How to install and deploy Communicator for Mac in a 
corporate environment 

Post-Installation Post-installation instructions that include how to integrate 
Communicator for Mac with Office for Mac 2011 and how to 
customize and deploy Communicator for Mac preferences. 

Technical Reference Additional resources for planning, deploying, and maintaining 
Communicator for Mac 

 

Features in Communicator for Mac 2011 
Microsoft Communicator for Mac 2011, the communications client for Macintosh computers, 
includes real-time audio calls, video calls, and new presence statuses to improve the way users find 
and connect with their coworkers. 

Important 

The corporate contact list is no longer part of the Messenger application. For Office 
Communications Server functionality, you need Microsoft Communicator for Mac 2011. 
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Rich presence 
• Calendar-based presence Communicator offers new presence statuses to more 

accurately reflect whether someone can communicate with you at that time. Based on 
your Exchange calendar, Communicator sets your status automatically. For example, if you 
are in a meeting, your status automatically changes to Busy (In a Meeting).  

• Presence in other Office for Mac applications Communicator is integrated with Office 
for Mac 2011, which allows you to collaborate with your contacts by starting a 
conversation from these Office applications: Word, PowerPoint, and Outlook. For example, 
while you are working in Outlook, you can rest the pointer on a status icon to see the 
contact card for your contact. The contact card shows the presence status for the contact 
in more detail, and gives you several communication options, such as sending an instant 
message, e-mail message, or meeting request, or starting an audio or video call. 

Audio, video, and conferencing 
• Audio or video calls You can make computer-to-computer audio and video calls. You can 

also conduct conference calls by inviting multiple contacts to join the conversation. By 
using the audio and video calling features in Communicator, you can see and hear your 
contacts. This provides an experience that is similar to meeting in person.  

You can make any of the following types of audio or video calls: 

o Start audio and video conversations from the conversation window with a contact 
in the corporate network.  

o Call a contact who is using either Communicator for Mac or Office 
Communications Server 2007 R2. 

o Call from Communicator to a federated network if both networks allow audio and 
video calls.  

o Call multiple participants. Participants who are invited to join the audio or video 
conference can leave the session at any time.  

 Note  You cannot make audio and video calls to contacts who use public instant-
messaging connectivity (PIC), such as AOL Instant Messenger (AIM) or Yahoo! 
Messenger.  
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• Join a virtual meeting With Communicator, you can join a scheduled virtual meeting with 
colleagues and clients from down the hall or across the world by clicking conf: URL in an 
Outlook meeting invite. For virtual meetings with audio or video calls, you can use a 
webcam, a microphone, and either speakers or headphones. If your computer does not 
have a built-in webcam and microphone, you can purchase a Mac-compatible device to 
attach to your computer. Users can set the preference for registering Communicator as the 
default client for conference URLs from the Preferences dialog box. To learn about how to 
set up these devices, see Mac Help. 

• Use your computer as a telephone Communicator allows you to place calls by using a 
dial pad, and use the dial pad during a call.  

If you use a computer to make or receive calls, you must have a microphone and either 
speakers or headphones. The computer's built-in microphone or a purchased Mac-
compatible microphone works with Communicator for Mac. To learn how to set up these 
devices, see Mac Help. For a sample list of supported devices, see "System requirements 
for Communicator for Mac 2011" below. 
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System requirements for Communicator for Mac 2011 
The following table lists the minimum hardware and software that you must have to install 
Microsoft Communicator for Mac 2011. 

Component Minimum requirement 

Display resolution Super VGA 1280 x 800  

Processor Intel only 

Operating system Mac OS X v10.5.8 or a later version 

Hard disk 300 MB of available hard disk space. This includes space for downloading the Global 
Address List (GAL). 

HFS+, also known as Mac OS Extended format 

Memory  1 GB of RAM or more 

Other requirements Microsoft Office Communications Server 2007 R2 

Office for Mac 2011 for new integration features  

Note  Microsoft Communicator for Mac 2011 does not work with Office 
Communications Server 2007 or earlier versions.  

 
Web browser  Safari 5  
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The following table lists the recommended minimum hardware and software for audio/video. 

Component Recommended for audio/video 

Video memory Video card with 64 MB of RAM 

Voice  Compatible microphone and speakers, headset with microphone, or equivalent 
device 

Sample devices include a built-in Apple iSight webcam and other external 
devices that are compatible with Mac OS X. 

Video Compatible webcam 

Sample devices include a built-in Apple iSight webcam and other external 
webcams that are compatible with Mac OS X. 

Internet 
connection 

Broadband 

 

Compare Communicator for Mac 2011 to 
Messenger for Mac 7 
The following table compares features between Communicator for Mac 2011 and Messenger for 
Mac 7 hosted on Office Communications Server 2007. 

 Feature included     Feature partially included or not completely functional    

 Feature not included  

Features Microsoft  
Communicator 
for Mac 2011 

Messenger for 
Mac 7 

Outbound/inbound audio calls from PSTN callers   

Quick access to conferences in Communicator for Mac 2011 by 
clicking conf: URL in a meeting request 

  

Calendar-based presence status, such as In a Meeting   

Outlook out-of-office messages appear in Communicator for 
Mac 
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Features Microsoft  
Communicator 
for Mac 2011 

Messenger for 
Mac 7 

Presence status integrated with Office for Mac 2011   

Access to the Conversation History from the conversation 
window  

  

Instant messaging (IM)   

Basic presence   

Computer-to-computer audio calls with Communicator for Mac 
2011 and Office Communicator for Windows users 

  

Computer-to-computer video calls with Communicator for Mac 
2011 and Office Communicator for Windows users 

  

Access to external federated users   

Public IM connectivity   

File transfer with Communicator for Mac 2011 clients   

Global Address List (GAL) search    

Integration for presence states between Communicator for Mac 
2011 and Office Communicator for Windows  

  

Support for NTLM and Kerberos protocol    
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Compare Communicator for Mac 2011 to 
Office Communicator 2007 R2 
Office Communicator 2007 R2 for Windows provides easy access to rich presence, instant 
messaging (IM), and other real-time communications capabilities. It enables information workers 
to communicate with each other more easily and quickly. Communicator for Mac 2011 has many 
of the same features as Office Communicator 2007 R2 for Windows. For example, many presence 
types that are available in Office Communicator 2007 R2 are also available in Communicator for 
Mac. The new and improved features in Communicator for Mac help maintain compatibility with 
Office Communicator 2007 R2 for Windows users. 

The following table compares the features that are available in Communicator for Mac with those 
in Office Communicator 2007 R2 for Windows. 

 Feature is included     Feature is not included    

Rich presence and instant messaging  Communicator 
for Mac 2011 

Office Communicator 
2007 R2 for Windows 

Send instant messages   

Display published phone numbers, organizational 
structure, and office information all on contact cards 

  

Set presence status manually or automatically based on 
calendar, login status, and more 

  

Specify access levels for sharing information with different 
contacts  

  

Connect with people outside the organization with public 
instant-messaging connectivity (PIC), such as AOL Instant 
Messenger (AIM), Yahoo! Messenger, and Windows Live 
Messenger 
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Enterprise Voice  Communicator 
for Mac 2011 

Office Communicator  
2007 R2 for Windows 

Place a call by clicking an Outlook or Communicator contact   

Receive calls on all registered endpoints (including mobile 
phones or other mobile devices) 

  

Receive call notifications on the computer    

Configure call forwarding in Communicator   

Access voice mail from either the computer or by calling an 
access number 

  

Use the Communicator dial pad to call external numbers   

 

Audio, video, and web conferencing Communicator 
for Mac 2011 

Office Communicator  
2007 R2 for Windows 

Connect using audio calls   

Connect using video calls    

Schedule conferences in Outlook   

Join conferences scheduled from Outlook   

Share your desktop with other contacts   
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Communicator for Mac 2011 topology 
In the enterprise environment, Microsoft Communicator for Mac 2011 and Microsoft Office 
Communications Server 2007 R2 combine to provide various functionalities including IM, presence 
status, audio/video conferencing, and Enterprise Voice. For more information on Communicator 
for Mac 2011 in the Office Communications Server environment, see Topology and Component 
Architecture . 

Installing and Configuring Communicator for Mac 
2011 on a Corporate Network 

Deploying Communicator for Mac 
To install Communicator for Mac 2011, use one of the following options: 

• Install by using Apple Remote Desktop  Communicator uses the Apple Installer for 
installation. The Apple Installer makes the installation process more efficient because the 
data that Communicator installs is in the .pkg format. Communicator Installer is 
compatible with Apple Remote Desktop and the installation applications are AppleScript 
ready. 

• Install from a software distribution point  You can download the installation image to a 
central location, such as the network file server. Then users can drag the installation image 
to their computers and install Communicator. 

To establish a standard set of preferences for users, you can customize the preferences for 
Communicator. For example, you can customize the preferences for setting a range of ports for 
audio/video sessions in the preference file and deploy the file to your client computers. For more 
information about managed preferences in Communicator for Mac 2011, see Communicator for 
Mac 2011 managed preferences.  

http://go.microsoft.com/fwlink/?LinkId=201577�
http://go.microsoft.com/fwlink/?LinkId=201577�
http://go.microsoft.com/fwlink/?LinkId=201577�
http://go.microsoft.com/fwlink/?LinkId=201577�
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Before users install, make sure that they have the following information to successfully set up 
Communicator. 

• Corporate account information, which includes the company e-mail address, domain 
name, user name or e-mail name, and password. 

• For automatic configuration of network settings, a Domain Name System server (DNS SRV) 
resource record. With automatic configuration enabled, the client automatically queries 
for a DNS SRV resource record. The client either connects directly or is redirected to the 
correct Office Communications Server. For instructions about how to create a DNS SRV 
resource record for the Office Communications Server deployment and more information 
about automatic configuration, see the Office Communications Server 2007  
documentation. 

• For manual configuration of network settings, the IP address or fully qualified domain 
name of the Office Communications Server and instructions on whether they should use 
Transport Connection Protocol (TCP) or Transport Layer Security (TLS). 

 Install by using Apple Remote Desktop 
1. Copy the installer to a writable volume. 

2. Set up Apple Remote Desktop to deploy Communicator to users' computers. 

As an added security measure, we strongly recommend that you lock the screens of the 
client computers before you deploy. If you use Apple Remote Desktop 3 or later to deploy 
Communicator, you can choose the options that lock the screens during installation.  

You may want to instruct users to leave their computers on overnight so that you can 
schedule the distribution during non-working hours. 

3. Select one or more computers in the Apple Remote Desktop window, and then click 

Install. Click Add  to add the package to install, and then click Install.  

This installs new software automatically and without user intervention by remotely 
installing installer packages (.pkg or .mpkg files) to one or more remote clients. Apple 
Remote Desktop installs the package to the computers that you choose, runs the installer 
with no visible window or user interaction required, and then erases the installer files on 
completion. 

http://go.microsoft.com/fwlink/?LinkId=113063�
http://go.microsoft.com/fwlink/?LinkId=113063�
http://go.microsoft.com/fwlink/?LinkId=113063�
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  Install from a software distribution point 
You can perform the following steps to install Communicator from a central location. 

  Step 1: Install from the central file location to client computers 
1. Save the installer package file to the central network location for file sharing. Set the user 

permissions for the network file share to allow authorized users to access the shared 
folder.  

For more information about how to set permissions, see your server documentation. Users 
can then install Communicator on their computers by performing the following steps. 

2. Double-click the installer file on the central file sharing location. 

3. Follow the instructions on the screen. 

  Step 2: Manually configure the connection to the  
   Office Communications Server 
 

 Note  Users should perform the following procedure only if the connection to the Office 
Communications Server is not automatically configured after users run the installer. Users 
should either have the IP address or name of the server. 

1. On the Communicator menu, click Preferences, and then click Account. 

2. Under My Network Settings, click Manually configure settings. 

3. Type the IP address or the fully qualified domain name of the Office Communications 
Server. 

4. Click TCP or TLS, and then click OK. 

Connecting to Office Communications Server 
By default, Communicator for Mac clients use Transport Layer Security (TLS) to connect to the 
Office Communications Server. If TLS is unavailable, Transport Connection Protocol (TCP) is used to 
establish the connection. 
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For TLS connections, users must have an X509 certificate to authenticate the server to the 
Communicator client. If the server uses a certificate from one of the root certification authorities 
(CAs) that is preinstalled on the client computer, the user does not have to install the certificate 
again. When a user signs in to a TLS connection, Communicator requests a valid certificate from 
the server. To be valid, the certificate must be from a CA trusted by the client. If the certificate is 
valid, the client authenticates the server and opens the connection. If the server uses a certificate 
that is generated from a certification authority that the Macintosh computer does not recognize, 
you have to manually import the certificate to the client computers before you deploy 
Communicator. 

To complete the certificate installation, you have to have access to the certificate file. You can issue 
a self-signed certificate, an identity certificate that is signed by its own creator, or you can 
purchase digital certificates from a certification authority. For more information about how to 
obtain a digital certificate from a certification authority, visit the Office Marketplace digital ID 
page  on the Microsoft  Office Online Web site (office.microsoft.com).  

Select one of the following procedures based on whether the Macintosh computer that you want 
to install the certificate on is running Mac OS X v10.5 (Leopard) or Mac OS X v10.6 (Snow 
Leopard). 

Install a certificate in Mac OS X v10.5 (Leopard) 
In Mac OS X v10.5 (Leopard), you must first add X509Anchors to Keychain Access. Then add the 
root certificate to X509Anchors. 

To add X509Anchors to Keychain Access, do the following: 
1. Open Keychain Access from /Applications/Utilities. 

2. On the File menu, click Add Keychain. 

3. Select the X509Anchors keychain from /System/Library/Keychains. 

To add the root certificate to X509Anchors, do the following: 
1. Double-click the certificate file (.cer) file to open it in the Keychain Access application. 

2. On the Keychain pop-up menu, click X509Anchors, and then click OK. 

If you are asked to provide a name and password, use the administrator credentials. 

3. Click View Certificates to verify the details of the certificate. 

http://go.microsoft.com/fwlink/?LinkID=92020�
http://go.microsoft.com/fwlink/?LinkID=92020�
http://go.microsoft.com/fwlink/?LinkID=92020�
http://go.microsoft.com/fwlink/?LinkID=92020�
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Install a certificate in Mac OS X v10.6 (Snow Leopard) 
1. Open Keychain Access from /Applications/Utilities. 

2. Drag the root certificate to the login Keychain.  

3. Click Always Trust.  

Uninstalling Communicator for Mac 
Follow these steps to uninstall Communicator. 

1. Log in to your computer with administrative credentials. 

2. Quit Communicator if it is running. 

3. Drag the Microsoft Communicator application to the Trash. 

4. To remove your existing Communicator preferences, delete the following files:  

o /Users/username/Library/Preferences/com.microsoft.Communicator.plist 

o /Users/username/Library/Preferences/ByHost/MicrosoftCommunicatorRegistration
DB.xxxx.plist 

o /Users/username/Library/Preferences/Microsoft/Microsoft Communicator User 
Cache.plist 

o /Users/username~/Library/Preferences/com.microsoft.autoupdate2.plist 

o /Users/username/Library/Logs/Microsoft-Communicator-0.log (this file is present 
only if you turned on Communicator Logging) 

5. To remove all Communicator files from your computer, delete the following folders in 
/Users/username/Documents/Microsoft User Data: 

o Microsoft Communicator Data 

o Microsoft Communicator History 

 Note  If you remove the Microsoft Communicator History folder, you will delete all 
conversations that are saved in the Conversation History. 
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Post-Installation 

Using Communicator for Mac 2011 with Office for Mac 
2011 
Communicator for Mac 2011 is tightly integrated into Outlook, and works seamlessly with other 
Office for Mac 2011 applications, such as Word and PowerPoint — the familiar applications that 
users employ daily.  

For example, while you are working in Outlook, you can rest the pointer on a status icon to see the 
contact card for your contact. The contact card shows the presence status for the contact in more 
detail, and gives you several communication options, such as sending an instant message, e-mail 
message, or meeting request, or starting an audio or video call. You can also add contacts to the 
Office Address Book directly from Communicator for Mac. From Outlook, you can use instant 
messaging to interact with Communicator contacts. You can also use the Instant Message option 
on the Review tab in Word to send a document in an instant message. 

 Office Address Book 

Add a contact to the Office Address Book 

1. In the Communicator for Mac Contact List window, click Add . 

2. Type the e-mail address for the contact whom you want to add. 

3. Select the Add this contact to the Office Address Book check box, complete the contact 
information, and then click Next. 

4. Click Finish. 

 Outlook 
Communicator is integrated with Outlook, so you can send an instant message (IM) or collaborate 
with other people on a project, directly from Outlook. 

 Note  Presence information is available in Outlook for any person who is using Communicator, 
regardless of whether he or she is in your contact list. 
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 Start an instant message conversation, or an audio or 
video call from Outlook 

In Outlook, you can interact with your Communicator contacts by sending an IM, or by making 
audio/video calls. For example, when an e-mail is displayed in the reading pane in Outlook, the 
presence status of the sender is shown beside the sender's name. You click the status icon to 
display the various options that you can use to communicate with the sender. The following 
procedure shows how to send an instant message from Outlook. 

1. At the bottom of the navigation panel, click Mail. 

2. In the Outlook reading pane, next to the sender's name, click the status icon. 

3. Click Send an instant message . 

 Join a virtual meeting 
With Communicator, you can join a scheduled virtual meeting with colleagues and clients from 
down the hall or across the world without leaving your desk.  

For virtual meetings with audio or video calls, you must have a webcam, a microphone, and either 
speakers or headphones. If your computer does not have a built-in webcam and microphone, you 
can purchase a Mac-compatible device to attach to your computer. To learn about how to set up 
these devices, see Mac Help. 

1. In the Outlook navigation pane, click Calendar, and then double-click the meeting 
invitation that contains the URL for the conference call. 

2. Do any of the following:  

To Do this 

Join the conference by using Communicator Click Join using Communicator. 

Join the conference by using a Web browser Click Join using a Web browser. 

 Word 
You can use Communicator directly from the Review tab in Word to send a document to reviewers 
and to send an instant message. You can also use the Share command on the File menu to send a 
file. 
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Send a document for review directly from Word 
To complete this procedure, you must be signed in to Communicator.  

1. Open the Word document that you want to send for review. 

2. On the Review tab, click Instant Message , and then click the name of the person 
to whom you want to send the document. 

If the person does not appear on the list, click Other, and then type the person's e-mail or 
instant messaging address. 

 Note  You can also share the document by using the Share command on the File 
menu. To use the Share command, on the File menu, point to Share, click Instant 
Message, and then click the name of the person to whom you want to send the 
document. 

 

Security best practices 
You can improve security in your organization by using the following best practices. 

• Configure Microsoft Communicator for Mac 2011 to use Transport Layer Security (TLS), 
which provides encrypted signaling. The confidentiality of otherwise-encrypted 
communications, such as media, is not protected when Transmission Control Protocol 
(TCP) is used to connect to the server. The encryption key can be intercepted by an 
attacker and used to decrypt the message. 

• Instruct users to run a virus check before they open transferred files. File transfer between 
users is peer-to-peer; by default, all file transfers are encrypted. 

• Reduce the access of external network connections to open ports on your local network. 
Knowing which ports are open can help you assess the security of the system or 
troubleshoot any connection issues. You should close the ports that you do not use. For 
more information about the ports that are used for audio/video sessions, see 
Communicator for Mac 2011 managed preferences 

• If you want to block specific features or functionality for your users, you can enforce 
computer level policies by using managed preferences. For more information about which 
features you can block, see Communicator for Mac 2011 managed preferences. 
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• Implement password-controlled access to the network. 

• The Communicator for Mac preference file is stored in the user's home folders: 
/Users/username/Library/Preferences/com.microsoft.Communicator.plist. The preference 
file contains security settings. Users should make sure that their home folders cannot be 
accessed by other unauthorized users. 

Deploying Communicator for Mac 2011 preferences 
If you customize Communicator for Mac preferences, you can choose one of the methods that is 
described below to deploy the preferences to users on the network. For more information about 
the preferences that you can manage, see Communicator for Mac 2011 managed preferences. 

Before you deploy the preferences, users must quit Communicator. The preference setting changes 
are applied when users reopen Communicator.  

 Deploying preferences by using Workgroup Manager 
You can use Workgroup Manager to deploy preferences and define privileges by user, by group, or 
by computer. You can also use it to perform a broad range of other workgroup management 
functions. It can deploy preferences either before or after users begin to work with Communicator 
because you can manage individual preferences in a .plist file without disrupting other settings in 
the same file. Workgroup Manager does not deploy whole .plist files; instead, it updates .plist files 
on users' computers by writing individual key/value pairs. 

When you customize preferences, the customized .plist files are stored in the home folder of the 
administrator account that you used to log in for that session. When you are ready to deploy these 
customized preferences, you must log in with that same administrator account because 
Workgroup Manager deploys the preference settings of the administrator who is currently logged 
in. 

For information about Workgroup Manager, see Client Management  in the Mac OS X Server 
area of the Apple Web site (www.apple.com/server). For detailed information about managing 
preferences with Workgroup Manager, see the Mac OS X Server User Management  
documentation available for download from the Apple Web site 
(www.apple.com/server/documentation). 

http://go.microsoft.com/fwlink/?LinkId=106770�
http://go.microsoft.com/fwlink/?LinkId=106770�
http://go.microsoft.com/fwlink/?LinkId=106762�
http://go.microsoft.com/fwlink/?LinkId=106762�
http://go.microsoft.com/fwlink/?LinkId=106770�
http://go.microsoft.com/fwlink/?LinkId=106762�
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 Deploying preferences by using Apple Remote Desktop 
You can create a special .pkg file specifically to deploy preferences. You can use Apple Remote 
Desktop to deploy this .pkg file to the home folders on users' computers. Or, you can make the file 
available for users to copy from a file server. 

For information about Apple Remote Desktop, see Apple Remote Desktop Administrator's 
Guide  on the Apple Web site at http://www.apple.com/remotedesktop. 

Turn on logging 
Logging is a diagnostic tool that is primarily used to help troubleshoot issues.  

When you turn on logging, Communicator creates log files and stores them in 
/Users/username/Library/Logs. If users are experiencing issues with the instant messaging service, 
ask them to turn on logging and send the report to you for diagnosis. 

Important 

Ask users to turn off logging after troubleshooting is completed. Otherwise, the log files 
continue to increase in size and consume hard disk space. 

1. On the Communicator menu, click Preferences, and then click General .  

2. Under Logging, select the Turn on logging for troubleshooting check box. 

 Note  Users must close and then reopen Communicator to start creating log files. 

 

http://go.microsoft.com/fwlink/?LinkId=106761�
http://go.microsoft.com/fwlink/?LinkId=106761�
http://go.microsoft.com/fwlink/?LinkId=106761�
http://go.microsoft.com/fwlink/?LinkId=106761�
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Technical Reference 

Communicator for Mac 2011 managed preferences 
Certain features and behaviors that are available to Microsoft Office Communications Server 2007 
R2 clients are determined by preference settings on the client. You can standardize the settings for 
Microsoft Communicator for Mac 2011 in your organization by configuring preferences for the 
application and then deploying these preferences to users on the network. The Office 
Communications Server 2007 R2 preferences are stored in the 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist or the 
User/username/Library/Preferences/ByHost/MicrosoftCommunicatorRegistrationDB-xxxx.plist. The 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist corresponds to the 
HKEY_LOCAL_MACHINE keys on a Windows-based computer. This means every user on the 
computer shares the same set of settings. You need Administrator privileges on the computer to 
modify the file in this folder. The 
User/username//Library/Preferences/ByHost/MicrosoftCommunicatorRegistrationDB-xxxx.plist 
corresponds to the HKEY_CURRENT_USER keys on a Windows-based computer. This means that 
users who are using the same computer can have different Communicator settings. The keys 
documented below are supported in either of these .plist files. However, the 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist key will override the 
~/Library/Preferences/ByHost/MicrosoftCommunicatorRegistrationDB-xxxx.plist file, if available.  

To add a new preference, in the /Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist 
file, use the following syntax: 
hkey_local_machine\software\policies\microsoft\communicator\<preferencename>. Use all 
lowercase letters for the preference entry. Before you add a new preference in the file, you must 
create the following default preference entries with the specified values in this .plist file:  

Preference Value  

Backward_Compatible_Version  1  

Current_Version 1  

hkey_local_machine\software\policies\microsoft\communicator\  <<MacRegNoValue>> 

 

 Note  To edit a .plist file, you can use a property list (plist) editor. A plist editor is available as 
part of the Apple XCode tool set. The default location for the plist editor on the hard disk is 
/Developer/Applications/Utilities/Property List Editor. Various third-party plist editors are also 
available. 
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The following table lists the Office Communications Server 2007 R2 preferences available for 
Communicator for Mac. 

Office Communication Server R2 policies for Communicator for Mac 2011  

AutoDiscoveryRetryInterval  

Setting Name: Time interval to retry the autodiscover service  
Value: Default = 30 

Min = 15 
Max = 4800 

Description: Set time interval to retry a failed automatic connection to the server.  
 

BlockConversationFromFederatedContacts  

Setting Name: Block conversation from federated contacts  
Value: Not present = User choice.  

0 = Allow conversation 
1 = Block conversation 

Description: Prevents federated contacts from starting an audio, video, or instant messaging 
session with a Communicator for Mac user.  

 

ConfiguredServerCheckValues 

Setting Name: Additional server versions supported  
Value: string (MaxLen 256)  

Description: Specifies a list of server version names separated by semicolons that 
Communicator will log on to, in addition to the server versions that are 
supported by default. For example, RTC/2.8;RTC/2.9.  

 Note  A space character is treated as part of the version string.  
 

CalendarStatePublicationInterval 

Setting Name: Time interval to publish calendar data to presence  
Value: If not present, the default value is 15.  

Min = 5  
Max = 480 

Description: Frequency of updates to presence from the Outlook Calendar.  
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ConfigurationMode  

Setting Name: Specify transport and server  
Value: Not present = User choice (default).  

0 = In the Options dialog box, on the Personal tab, under My account, the 
Advanced button is unavailable, and the connection is automatic.  
1 = The Advanced button is enabled. The server locations and transport 
mechanism must be supplied by the ServerAddressInternal, 
ServerAddressExternal, and Transport policy settings.  

Description: Specifies how Communicator identifies the transport and server. If you enable 
this policy, you must specify the transport and either the server name or server 
IP address that Communicator will use. If this policy is not present, the user can 
choose automatic configuration, or specify the transport and server name in the 
Communicator Options dialog box (on the Personal tab, under My account, 
click Advanced).  

 Note  You can configure this policy under both 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist and the 
~/Library/Preferences/ByHost/MicrosoftCommunicatorRegistrationDB-
xxxx.plist, but the policy setting under 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist takes 
precedence.  

 

DisableCalendarPresence 

Setting Name: Disable Calendar Presence 
Value: 0 or not present = Calendar data is published per the Update my presence 

based on Exchange calendar information option on the Account tab. The 
user’s presence status will change to In a meeting based on Calendar data 
(default).  
1 = Feature is disabled and Calendar data is not published. The user’s presence 
status will not change to In a meeting based on Calendar data. 

Description: Disables the loading of free or busy data from the Microsoft Outlook messaging 
and collaboration client, and prevents this data from being published.  
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DisableFileTransfer 

Setting Name: Prevent file transfer 
Value: 0 = File transfer is enabled (default).  

1 = File transfer is disabled. 
Description: Disables the File Transfer command. 

 

DisablePhonePresence 

Setting Name: Disable Call Presence 
Value: 0 = Phone call (VoIP and conference) states are published (default).  

1 = Phone call states are not published to presence. 
Description: Prevents phone call states from being published as part of the presence 

information. 
 

DisablePresenceNote 

Setting Name: Disable Presence Note 
Value: 0 (or not set) = User is allowed to set the presence and Out of Office message. 

Out of Office message is published, per the Display my Out of Office 
information to my contacts option on the Account tab (default).  
1 = Feature is disabled; OOF note is not published. 

Description: Prevents users from selecting or clearing the Automatically retrieve Out of Office 
settings from Outlook check box on the Personal tab of the Options dialog box.  

 

EnableAppearOffline 

Setting Name: Enable the state Appear Offline 
Value: 0 or not present = All user interface entry points for this option are disabled 

(default).  
1 = Users can manually choose Appear Offline on the Office Communicator 
Presence menu. 

Description: Allows users to manually set presence status to Appear Offline. User interface 
entry points for this feature do not appear when this policy is not present, or is 
set to 0.  
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EnableStrictDNSNaming 

Setting Name: Enable strict DNS naming for server name 
Value: 0 = Communicator can communicate using TLS transport with any SIP server 

that has an FQDN that ends with the domain portion of the user’s SIP URI 
(default).  
1 = Communicator can communicate with a SIP server using TLS transport only if 
the server’s FQDN is an exact match with the domain in the domain portion of 
the user’s SIP URI, or the FQDN is sip. followed by the domain portion of the 
user’s SIP URI, for example, sip.contoso.com.  

Description: Allows Communicator to automatically detect and securely communicate with 
SIP servers that have non-standard fully qualified domain names (FQDNs).  

 

Note  This policy setting only takes effect if Communicator uses Domain 
Name Server (DNS) lookup to query a list of SIP servers, and only if 
Communicator communicates with the SIP server using the Transport Layer 
Security (TLS) protocol. In this case, the set of supported server FQDNs 
depends on the SIP Uniform Resource Identifier (URI) of the user who starts 
Communicator. You can configure this policy under both 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist and 
~/Library/Preferences/ByHost/MicrosoftCommunicatorRegistrationDB-
xxxx.plist, but the policy setting under 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist takes 
precedence.   

 

EnableURL 

Setting Name: Allow hyperlinks in instant messages 
Value: 0 = Communicator will disable hyperlinks in instant messages. Hyperlinks will 

appear as text only in the instant message (default).  
1 = Communicator will allow active hyperlinks in instant messages. 

Description: Enables hyperlinks in instant messages. 
 

MaxAudioVideoBitRate 

Setting Name: Limit bandwidth for audio and video calls  
Value: 0 (or not set) = Communicator uses as much bandwidth as is available and 

necessary for audio and video calls (default). The maximum value for this setting 
is 1,000,000 bits per second. 

Description: Limits bandwidth that Communicator can use for audio and video calls. 
 



 

Technical Reference 

   25 

Portrange\Enabled  

Setting Name: Specify dynamic port ranges  
Value: 0 (or not set) = Ranges are dynamic (default).  

1 = Ranges are controlled by the sub policies.  
Description: The Portrange subvalues specify the ranges of dynamically-allocated ports that 

Communicator can use to transmit signaling data using SIP, and to transmit 
audio and video data using RTP. Set in 
/Library/Preferences/MicrosoftCommunicatorRegistrationDB.plist only. Cannot 
be set on a per-user basis.  

 Note  If enabled, this policy prohibits overlapping SIP and RTP port ranges.  
 

Portrange\MaxMediaPort  

Setting Name: Specify maximum media port ranges  
Value: DEFAULT = 5353  

Minimum= 1024  
Maximum = 65535  

Description: See Portrange\Enabled 
 

Portrange\MinMediaPort  

Setting Name: Specify minimum media port ranges  
Value: DEFAULT = 5350  

MIN = 1024  
MAX = 65535  

Description: See Portrange\Enabled 
 

ServerAddressInternal 

Setting Name: Server Address Internal  
Value: string (MaxLen 256)  

Description: Specifies the server name or IP address used by Communicator when connecting 
from inside the organization’s firewall.  
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TelephonyMode 

Setting Name: Specify Telephony Mode 
Value: 0 = Enable computer-to-computer calling only. 

1, 2 or 3 = Enable enterprise voice telephony features. 
4 or 5 = Instant Message and Presence only. No audio/video support.  

Description: Enables Remote Call Control (RCC), Unified Communications enterprise voice 
telephony, or both. For RCC, you must also set the Office Communications Server 
2007 LineServer attribute.  

 

Transport 

Setting Name: Specify Transport protocol 
Value: 2 = TCP (default)  

4 = TLS  
Description: Defines the network protocol used by Communicator: Transmission Control 

Protocol (TCP) or Transport Layer Security (TLS).  
 

WebServicePollInterval  

Setting Name: Time interval to load calendar data from Outlook 
Value: Default = 30  

Min = 15 
Max = 4800  

Description: Specifies the frequency (in minutes) of loading calendar data from Outlook.  
 

Communicator for Mac 2011 user preferences 
The default list of user preferences is stored in 
/Users/username/Library/Preferences/com.microsoft.Communicator.plist. 

Preference Description 

AcceptedSLT### Shows if the user has accepted the license agreement for 
a specific version of Communicator 

AddContactLocation Shows the last location of the upper-left corner of the 
Add Contact dialog box, in "left, top" format  

AddedToContactListDialogLocation Shows the last location of the upper-left corner of the 
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Preference Description 

Contact Has Added You dialog box, in "left, top" format  

AllowSIPUnencryptedFileTransfer  Allows transfer of files that are not encrypted  

AppleNavServices Shows the Apple preference items for the file locator 
dialog box 

AudioVolume Shows the audio volume for audio/video sessions that the 
user has set 

AutoIdleDelay Shows the minutes before status is set to Away  

BounceOnlyOnce Bounces icon in Dock one time or continuously when an 
instant message arrives 

ContactOnlineSound Shows the name of the sound to be played when a 
contact goes online 

CorporateContactWindowLocation Shows the last location of the upper-left corner of the 
Contacts list window, in "left, top" format  

CorporateContactWindowSize Shows the last size of the Contacts list window, in "width, 
height" format  

DisableSpellAsYouType  Disables the spelling checker as users type 

DisallowSave Disables message archiving to prevent users from saving 
conversations 

DoNotRunMessengerOnStartup Does not run Communicator when computer starts 

DoNotShowArchivePrefChangedAlert Does not show the “message archive options changed” 
message again 

DoNotShowBlockAlert Does not show the “user blocked” message again 

DoNotShowAlertsInFullScreen  Does not show alerts when in full screen  

DoNotShowCloseContactListAlert Does not show the “contact list window closed” message 
again 

DoNotShowConfProviderAlert  Does not show the alert when the user sets 
Communicator as the default application for handling 
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Preference Description 

conference links 

DoNotShowDropOutOfIMAlert Does not show the “user leaving instant message 
conversation” message again 

DoNotShowOpenFileAlert Does not show the warning message when clicking an 
FTP hyperlink again 

DoNotShowPresenceProviderAlert Does not show alerts when the user sets Communicator 
as the default application for providing presence 
information for Office 

DoNotShowTelProviderAlert  Does not show the alert when the user sets 
Communicator as the default application for handling 
telephone calls  

DoNotShowUnblockAlert Does not show the “user unblocked” message again 

DoNotShowVirusAlert Does not show the “file transfer virus” message again 

DontAutoIdle Does not automatically set status to away (default = true) 

DontBounceDockIcon Does not bounce icon in Dock when an instant message 
arrives 

EnableAlertsForDoNotDisturb Enables the alerts for Do Not Disturb 

EnableKerberosLogin Enables Kerberos protocol for authentication  

fBonjourCollapsedSIP Collapses or expands the Bonjour list in the Contact List 

GroupOfflineTogetherSIP Groups offline contacts together in the contact list 

GroupsViewEverUsed Shows whether the user ever viewed the contact list in 
groups view 

HideContactOnlineToasts Does not show a message when a contact comes online 

HideCorporateContactsWindow Does not show the Communicator Contact List window 

HideDisplayPictureDrawer Does not open the user display picture drawer from the 
instant message window when a new instant message 
window is opened  
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Preference Description 

HideEmoticons Shows emoticons as text when they are received in the 
instant message window 

HideGALSearchPane Hides the Global Address List search pane 

HideIncomingCallToasts Does not show a message when a call is received 

HideIncomingVideoToasts Does not show a message when a video request is 
received 

HideInlineDisplayPictures Does not show inline user pictures in the instant message 
window 

HideInternetAlerts Does not show the message “new instant message is 
received” when an instant message/history window is in 
front, Communicator is not front-most application, or the 
current instant message window is minimized 

HideTimeStamp  Does not show time stamps for instant messages sent and 
received  

HIToolbar Config  Shows the Apple preference items for toolbar 
customization  

IncomingCallSound  Shows the selected type of sound that plays for an 
incoming call 

InstantMessageTextStyles  Shows the current instant message styles that are used in 
custom defined format and stored as raw data  

NavPanelPreferredColumnContentWidth Shows the Apple preference items for file locator dialog 
box 

NewAlertSound  Shows the name of the sound to be played when a 
message is shown  

NewMailSound  Shows the name of the sound to be played when an e-
mail message is received  

NewMessageSound  Shows the name of the sound to be played when an 
instant message is received  
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Preference Description 

OfflineCollapsedSIP  Shows the Offline group collapsed 

OnlineCollapsedSIP  Shows the Online group collapsed 

OutgoingCallSound  Shows the name of the sound to be played when the user 
starts an audio/video call 

PreferencesDialogLocation  Shows the last location of the upper-left corner of the 
Preferences dialog box, in "left, top" format  

PreferencesTabValue  Shows the active preferences tab, starting from 0 as the 
left-most tab  

ReceivedFileLocation Shows the full path of the location where the received file 
is to be saved 

SaveSIPPassword  Saves the password for an account 

SendOtherLocation  Shows the last location of the upper-left corner of the 
Send Other dialog box, in "left, top" format  

SetFontLocation  Shows the last location of the upper-left corner of the 
Font dialog box, in "left, top" format  

ShowGroupsSIP  Shows contacts in groups view for the corporate account  

SignInDialogLocation  Shows the last location of the upper-left corner of the 
Sign In dialog box, in "left, top" format  

SIPAccountSettingsLocation  Shows the last location of the upper-left corner of the 
corporate service account settings dialog box, in "left, 
top" format  

SIPSignInMRU01 - SIPSignInMRU05  Lists the five most recent e-mail addresses used to try to 
sign in to SIP service  

SIPSignInStatus  Shows the sign-in status for the user account  

SuppressContactSounds  Does not play sounds for any notifications  

UseKerberosLoginChecked  Uses Kerberos protocol as the default authentication 
method at login 
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Preference Description 

UserHasRunMessenger130 Shows that the user has run Microsoft Communicator for 
Mac 2011 

UserLogonName  Shows the user ID for corporate account sign in  

UserSIPID  Shows the user name  

WebContinuousSpellCheckingEnabled  Applies to WebKit preferences 

WebIconDatabaseDirectoryDefaultsKey  Applies to WebKit preferences 
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